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Evaluation Board for the AD4000 Series 16-/18-/20-Bit Precision SAR ADCs

FEATURES

Fully featured evaluation board for 10-lead precision ADCs

Versatile analog signal conditioning circuitry

On-board reference, reference buffers, and ADC drivers

PC software for control and data analysis of time and
frequency domain

System demonstration platform-compatible (EVAL-SDP-CH1Z)

EVALUATION BOARD KIT CONTENTS

AD4000/AD4001/AD4003/AD4020 evaluation board
(see Table 6)
12V wall adapter power supply

EQUIPMENT NEEDED

SDP-H1 board (EVAL-SDP-CH1Z)

Precision signal source

Cable (SMA input to evaluation board)

Standard USB A to mini-B USB cable

Band-pass filter suitable for 16-bit, 18-bit, and 20-bit testing
(value based on signal frequency)

GENERAL DESCRIPTION

The AD4000/AD4001/AD4003/AD4020 family evaluation
board covers the ease of use, 16-/18-/20-bit, precision successive
approximation register (SAR) analog-to-digital converters (ADCs).
The AD4000/AD4001/AD4003/AD4020 are low power, 16-bit/
18-bit/20-bit, precision SAR ADCs that offer very high perfor-
mance with throughputs up to 2 MSPS (1.8 MSPS for the AD4020).
The evaluation board is designed to demonstrate the performance

PLEASE SEE THE LAST PAGE FOR AN IMPORTANT
WARNING AND LEGAL TERMS AND CONDITIONS.

of the AD4000/AD4001/AD4003/AD4020 family of ADCs and
to provide an easy to understand interface for a variety of system
applications. A full description of these products is available in
their respective data sheets, which must be consulted when
using this evaluation board.

The EVAL-AD4000FMCZ/EVAL-AD4001FMCZ/EVAL-
AD4003FMCZ/EVAL-AD4020FMCZ evaluation boards (see
Figure 1) are ideal for use with the Analog Devices, Inc., high
speed system demonstration platform (EVAL-SDP-CH1Z).
These evaluation boards interface to the SDP-H1 board via a
120-pin connector. SMA connectors, JP2 and JP3, are provided
for the low noise analog signal source.

On-board components include a high precision buffered band gap
5.0 V reference (the ADR4550), a reference buffer (the ADA4807-1),
a common-mode buffer (the ADA4807-1), a signal conditioning
circuit with two op amps (the ADA4807-1), and a power supply to
derive the necessary voltage levels to supply all voltage needs.

The EVAL-AD4000FMCZ, EVAL-AD4001FMCZ, and EVAL-
AD4003FMCZ are populated with the AD4000, AD4001, and
ADA4003, respectively. However, these boards can be used to
evaluate the performance of the AD4004, AD4005, AD4007,
AD4008, and AD4011 by limiting the sample rate in the
evaluation software to the maximum sample rate of the specific
ADC. For example, the AD4000 on the EVAL-AD4000FMCZ
can be used to evaluate the performance of the AD4004 if the
sample rate is limited to 1 MSPS. See the data sheet of each
product for its corresponding evaluation board.
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Figure 2. Simplified Evaluation Board Block Diagram

SETTING UP THE EVALUATION BOARD

Figure 2 shows the simplified evaluation board block diagram.
Figure 25 shows the evaluation board schematic. The board
consists of the ADC, U1, with a reference, U6 (ADR4550), and
ADC drivers, U12 and U14, the ADA4807-1 for the AD4001/
AD4003/AD4020 and the ADA4805-1 for the AD4000 (see
Table 5). The user also has an option to use a low power, fully
differential ADC driver, U2, by populating the ADA4940-1. The
evaluation board is a flexible design that enables the user to
select components in addition to operating from an adjustable
bench top power supply.

POWER SUPPLIES

The system demonstration platform (SDP-H1) board supplies
12 V to power the necessary rails for the AD4000/AD4001/
ADA4003/AD4020 evaluation board.

Table 1. Power Supplies Provided on the Board

Power Supply (V) Function Components Used

5, 7 (default)’ Positive rail ADP7118

-5, =2.5 (default)’ Negative rail ADP2370, ADM660,
ADP7182

1.8 ADC power ADP7118, ADP5300

33 Vorve (digital power) | ADP7118

' See Table 2.

The 7 V amplifier positive rail (+Vs) is generated from U17 (the
ADP7118). The 2.5 V negative amplifier rail (—Vs) is generated
by a combination of U3 (the ADP2370), U7 (the ADM660), and
U21 (the ADP7182).

Each supply is decoupled where it enters the board and again at
each device. A single ground plane is used on this board to
minimize the effect of high frequency noise interference.

In addition, there is also the ability to power the board from a
bench top power supply. The screw terminals, J2 and J3, are
provided for this function. When bench power is used, the on-
board power supplies are no longer required. The solder links also
must be changed: SL1 = SL2 = SL5 = SL6 = SL7 = SL8 = SL9 = B.

REFERENCE, REFERENCE BUFFER, AND COMMON-
MODE BUFFER

An external 5 V reference (U6, ADR4550) is used by default to
supply the ADCs directly. However, the user can also use one of
the 2.5V, 3.3V, and 4.096 V references by changing the reference
device on the board (U6, ADR4525/ADR4533/ADR4540).
There is also an option to use a lower power reference (U22,
ADR3450). Note that the ADR3450 cannot accept input voltages
beyond 5.5 V. The ADA4807-1 is used as a reference buffer (U16)
and common-mode buffer (U18) by default. However, it can also
be replaced by the AD8031 if needed without compromising the
performance.

SDP-H1 CONTROLLER BOARD

The evaluation board uses a serial port interface (SPI) and is
connected to the high speed controller board for the system
demonstration platform (SDP-H1) controller board. The SDP-H1
board requires power from a 12 V wall adapter. The SDP-H1 has
a Xilinx® Spartan 6 and an ADSP-BF527 processor with
connectivity to the PC through a USB 2.0 high speed port. The
controller boards allow the configuration and capture of data on
daughter boards from the PC via USB.
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The SDP-H1 has an FMC low pin count (LPC) connector with
full differential LVDS and singled-ended LVCMOS support. It
also has the 120-pin connector, found on the SDP-B, which
exposes the Blackfin® processor peripherals. This connector
provides a configurable serial, parallel I’C and SPI, and general
purpose input/output (GPIO) communications lines to the
attached daughter board.

SOLDER LINKS

The three solder link options on the board are configured
depending on which generic of the ADC is on the specific
evaluation board, as described in Table 3.

Table 2. Jumper Detail with Factory Default Setting

Table 3. Jumpers Specific to 10-Lead Precision ADCs

Link | Default | Function Comment
SL1 A +Vs Change to B if using bench
supplies
SL2 | A -Vs Change to B if using bench
supplies
SL5 | A +Vs Change to B if using bench
supplies
SL6 | A -Vs Change to B if using bench
supplies
SL7 | A VDD for Change to B if using bench
ADC supplies
SL8 | A -Vs Change to B if using bench
supplies
SL9 | A +Vs Change to B if using bench
supplies
LK2 | A VREF Change to B if using the ADR3450
LK5 B SDI Change to A if using V_DRIVE
JP1 B FSEL (U3) Change to A if using Ground
JP2 B ADC Change to A if using FDA
drivers ADA4940-1
JP3 B ADC Change to A if using FDA
drivers ADA4940-1
JP4 B ADC Change to A if using FDA
drivers ADA4940-1
JP5 B ADC Change to A if using FDA
drivers ADA4940-1
JP7 B V_DRIVE Change to A if using external
3.3V forV_DRIVE
JP8 B STOP (U20) | Change to A if using CNV_FMC
from SDP-H1 connector

Link | Default | Configuration Generic
SL4 A Differential input AD4001, AD4003,
AD4020
SL4 | B Single-ended or AD4000
pseudo differential
ANALOG INPUTS

The analog inputs to the evaluation board are SMA connectors,
J6 and J10. These inputs are buffered with dedicated amplifier
circuitry (U12 and U14), as shown in Figure 25. The circuit allows
different configurations, input range scaling, filtering, addition of a
dc component, and use of different op amp and supplies. The
analog input amplifiers are set as unity-gain buffers at the factory.

The default configuration sets both U12 and U14 at midscale,
generated from a buffered reference voltage divider (VCM).

The evaluation board is factory configured to provide either a
single-ended path or a fully differential path.

For dynamic performance, a fast Fourier transform (FFT) test
can be performed by applying a very low distortion ac source.

For low frequency testing, the audio precision source (such as the
SYS-2700 series) can be used directly because the outputs on these
are isolated. Set the outputs for balanced and floating ground.
Different precision sources can be used with additional filtering.

Because the evaluation board uses the amplifiers in unity-gain,
the noninverting input has a common-mode input with a 590 Q
resistor divider, and it must be taken into account when directly
connecting a source.
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EVALUATION BOARD SOFTWARE

INSTALLING THE SOFTWARE 2. Choose the folder location for installation and click Next.

The evaluation board software can be downloaded from the The default folder is shown in Figure 4.

relevant product page on the Analog Devices website. T o
Destination Dwsctary

Install the software before connecting the SDP-H1 board to the St pecsyteBobon Seacicy

USB port of the PC to ensure that the SDP-H1 board is recognized

when it connects to the PC. Al saltware vell be installed in the follavwg bocahions. To install software inka a difkerent

location. dick the Browse bution and select another directony.

1.  Start the Windows® operating system and download the
software from the relevant product page on the Analog
Devices website.

Direcsony for ADAI Evalustion Sclwere

2. Unzip the downloaded file. Run the setup.exe file. [Frmaiiea Euens
3. After installation is completed, power up the evaluation
board as described in the Power Supplies section. T _
4.  Plug the evaluation board into the SDP-H1 board and the kil | b | g
SDP-H1 board into the PC using a USB cable. L s | toan J| Swes g
5. When the software detects the evaluation board, proceed Figure 4. Destination Directory
through any dialog boxes that appear to finalize the . .
) 8 ) Y 8 pp 3. Accept the National Instruments software license
installation. .
agreement and click Next.
The default location for the software is the following: B P e o e e S
C:\Program Files\Analog Devices\AD40XX Evaluation Ueense Agrosmunt ]
v mragst mccipt e ficerres displayed below o proceed
Software\EVAL-AD40XX.
MATIOMAL INSTRUMENTS SOFTWARE LICENSE AGREEMENT
This location contains the executable software and example files. TR AT HOTICE T 1A .
INSTALLATION FROCESE, CAREFULLY READ THES AGS ¥ THE S0FTWARE ANDIOR CLICKING THE
APPLICADUD DUTTON TO COMPLITE THE MSTALLATI T TIIE_TI:RHG:I' TIIIS:‘E-RI: INCHT §
INSTALLATION STEPS : T CANCEL T NSTALLATCN
.'JRF"IRI‘-.YHF 3D.F.'W le’fTF.I.N':Hﬁ'WLf@ ” _i?iﬁFF!F:Y
Proceed through the installation aHOWlng the Software and [OATAIMED THEM ALL RETURNS SHALL b r.l.n.rr:rT?)Nr.n‘f"\.L’::—‘:‘Lrtlg:;ﬁ’v;‘r‘:um;rﬂ:J'.'f'm“_%l o pasE
>
drivers to be placed in the appropriate locations. Connect the e s e e
. B ZScagime Inadiubon “MEInS 3§ Sepriegranteg educational inssiuon
SDP-HI board to the PC only after the software and drivers are b e et e et
inStalled Tha safwane i which Tis Nationsl ixsmemants licensa applias i Ansion Devices ADA003 Evaluntion Sofware
. . . . & | accegl the Licers Agraement)
There are two parts to the software installation. First, install the et accapt e Lo Aot .
software related to the evaluation board, as follows: T mrrr—T w—— Z
. Il g
1. Launch the evaluation board software installation by Figure 5. License Agreement
clicking the setup.exe file. The software installation Click i+ 10 ingtall the gof
window opens, as shown in Figure 3. 4. ick Next again to install the software.
i e S =rEes — =20
Stad Installaben
Fivitw the follewing summary befors contiteing
ADADXX Evaluation Sobtware Install
Adding or Changing
« ADAT Evalanton Sobwara Filag
11 ateeghy reCoenm AR hatyou el al progieme bEloes waning e inseles
Agpicatons that run in s background, suth asvius-scannng vibbes. might
cause the instaliar o take longer than everage o complete
e
Chick the Neod bution %0 begin installation. Click the Back bution o change e indtallation sefings.
] e ; | Sove e cepiock [ Mear | Goncal §

Figure 3. Evaluation Software Install Figure 6. Start Installation
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5.

The second part of the software installation is the drivers related

A pop-up window opens and displays a bar showing the
installation progress, as shown in Figure 7.

- 1 ADACE Ealusbion Saolbwre = | &

Ohverall Frogress: 89% Complete

14981-006

[ -.;amial
Figure 7. Overall Progress

Click Next to complete the installation and to launch the
SDP-H1 driver installation as shown in Figure 9.

(12 AD4EX Evalustion Soltware = |

Th it e Frschond . gelotie ot systesn

bima s

14981-007

Figure 8. Installation Complete

to the SDP-H1 board. These drivers must be installed for the
evaluation board to function correctly.

RT Please wait while Setup is loading. ..
5

verifying installer; 47%:

14981-008

Figure 9. Beginning of SDP-H1 Driver Installation

1.

2.

3.

The ADI SDP Drivers Setup Wizard opens. Click Next to
install the SDP-H1 drivers.

3] ADT SDF Drivers 2.2.95.68 Setup o] B |2

Welcome to the ADI SDP Drivers
2.2.95.68 Setup Wizard

This wizard will guide you through the installation of ADI SDP
Drivers 2,2,95.65,

It is recommended that vou close all ather applications
before starting Setup, This will make it possible to update
relevant system files without having to reboot vour
computer,

Click Mext to continue.

Canicel

Figure 10. ADI SDP Drivers Setup Wizard

14981-009

Choose the installation location and click Install; the
default folder is shown in Figure 11.

3/ 4D SDP Drivers 2.2.95.68 Setup =nR=R<)

Choose Install Location
Chonse the Folder in which to install ADI SDP Drivers 2.2,95.68, u

Setup will install ADI SDP Drivers 2,295,685 in the following folder. Toinstall in a different
Folder, click Browse and select another Folder. Click Install ko skart the installation.

Destination Folder

[_:1Program Filesianalog Device ‘D Browse. ..

Space required: 23,4MG
Space available: 34.7GB

| < Back |[ Install ]| Cancel

14981-010

Figure 11. Choose Install Location
The installation begins, and a progress bar is displayed.

3| AD1 SDP Drivers 2.2.95.68 Setup o = || &=

Installing
Please wait while ADI SDP Drivers 2.2.95.68 is being installed. D

Execute: "C:\Windows\ TEMPinsv1DC2 bmplMSYCRedist 10SP1_xS6iveredist_x86 exe" jq
L]

Installing the Visual C++ 2010 SP1 66 Runtime, This may take several minutes,
Qutput Folder: ChWwindows TEMPYnsy 1DCZ. tmplMSYCRedist LOSP1_x86

Extract: veredisk_x86.exe

Execute: "C:\Windows\ TEMPnsy1DC2 bmplMSYCRedist 10SPL_x86veredist_x86.ex...

< Back Close Cancel

14981-011

Figure 12. Installing
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4. Click Close to complete the installation.

3 AD1SDP Drivers 2.2.95.68 Setup =l =@ ]| 2=
Installation Complete
Setup was completed successfully, u
Completed
Extract: WinUSECaInstaller dl... 100% -

Extract: adisdp_x64.cat... 100%

Extract: AdiSdp_x64.inf... 100%

Extract: dpinst.exe... 100%

Installing Drivers

Execute: "C:\Program Files\analog Devices\SDP\DriversR 2 dpinst.exe” fsw fsa fpath ...
Driver Install exit code = -1073741205

Oukput Folder: C:iProgram Files\Analog Devices\SOP\DriversR2

Created uninstaller: C:\Program Files\analog Devices, SDPDriversRZ\uninst. exe
Completed il

m

< Back Cancel

14981-012

Figure 13. Installation Complete

When you first plug in the SDP-H1 board via the USB cable
provided, allow the Found New Hardware Wizard to run. You
can check that the drivers and the board are connected correctly by
looking at the Device Manager of the PC. Analog Devices
System Development Platform (32MB) appears under ADI
Development Tools.

A Computer Management

File  Action View Help
= 2E HE &

& Computer Management (Local [ &
4 ffb System Tools

& ADI Development Tools

(@) Task Scheduler & Analog Devices Syster Developrent Platform (32MB)
{2 Event Viewer [ 1% Computer
w| Shared Folders 1 Disk drives
- @ Local Users and Groups & B, Display adapters
@b Reliability and Performe | 13 DVD/CD-ROM drives
4 Device Manager w35 Human Interface Devices
4 2 Storage (- IDE ATA/ATAPI controllers
2% Disk Management 2= Keyboards 2
Zy Services and Applications & [ Mice and other pointing devices it
= B Monitors g

Figure 14. Device Manager

BOARD OPERATION/CONNECTION SEQUENCE

The following is the board operation/connection sequence:

1. Connect the SDP-H1 controller board to the evaluation
board with the J5 connector (screw into place as required).
The software is configured to find the evaluation board on
either connector of the SDP-H1 board.

2. Power the board with the appropriate supply, as described
in the Power Supplies section.

3. Connect the board to the PC with the USB cable.

4. Launch the software. Click Start > All Programs > Analog
Devices\AD40XX Evaluation Software\EVAL-AD40XX.

5. Apply the signal source and capture the data.

RUNNING THE SOFTWARE WITH THE HARDWARE
CONNECTED

To run the program, take the following steps:

1. Click Start > All Programs > Analog Devices > AD40XX
Evaluation Software > EVAL-AD40XX. To uninstall the
program, click Start > Control Panel > Programs and
Features > Analog Devices AD40XX Evaluation Software.

2. The software automatically seeks to find the hardware
connected; therefore, when no hardware is connected, it
displays a connectivity error (see Figure 15) when the
software is launched. Connect the evaluation board to the
SDP-H1 and connect the SDP-H1 to the USB port of the PC,
wait a few seconds, click Rescan, and then follow the
instructions.

I: Harduvare Select E3

Mo rmatching systern found, Press Rescan to retry or
Cancel to abort,

If wour SDP is recently connected, it may be in the
process of booting, Wait ~40secs and Rescan,

Previous Mext

Rescan Select Cancel

Figure 15. SDP-H1 Board Not Connected to the USB Port Error

14981-014

3. If Cancel is clicked, a message appears as shown in
Figure 16.

-

3 soP 21 Error! (el

! SDPERROR 110005: o connection
rmade

Figure 16. SDP-H1 Board Not Connected to the USB Port Error

14981-015

4. The software then connects to the board and displays the
message shown in Figure 17.

System Developrment Platform Wait 3

Wfaiting for operation to complete and

Cancel

Figure 17. Software Connects to SDP-H1 Board

14981-016

5. When the board is correctly detected, the software panel
opens.
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SOFTWARE OPERATION

When the software launches, the panel opens and the software
searches for the hardware connected to the PC. The software
detects the generic attached to the PC, and the software panel
then launches as shown in Figure 18.

File Edit Help 1

AD400X Evaluation Software > falerad

Configure IWaveform | Histograrm | FFT | Summary | Samples| 32768 EI[ Single Capture %Continuous Capture]l 0

Eval Board Connected

AD4000FMCZ 2

Enable Status Bits
Voltage Reference Span Comprassion
SV B -
Py, High-Z Mode 10
COversampling Ratio
Y 4.096% [ Turbo Mode 11
one [=] 3.3y
' 2TO S 14y
Throughput 2.5V [DHF Read Register
_ZDDD KPS 8 J,._| i"""""
J EF UWD @ status Header
AD4000 @ span Compression
VREF— VN ey Tosy .
vnmﬁb @ High-z Mode
1 — " ‘ l&onmnns @ Turbo Mode
© ] SPIIMTERFACE .Overvoltage Clamp Flag
Jmms*rcumn.@}
Status Header  Status\Word
]
Span Compression @
High-Z Mode @
Turbo Mode @
Cvervoltage Clamp Flag.
|
. \ g
Errar! “ersion 1.1.0.0 Busy . =
/I

Figure 18. Setup Screen
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DESCRIPTION OF THE USER PANEL

The following is the description of the user panel.

The File menu (Label 1 in Figure 18) has the choice of the
following options:

e  Save Captured Data allows the user to save the current
captured data for later analysis; the file format is .csv. The
user is prompted to choose or enter the path of the file in
the Save As dialog box (see Figure 19). Save to an
appropriate folder location.

e Load Captured Data opens the Load File dialog box, where
the user is prompted to load previously captured data in .csv
format for analysis.

e  Take Screenshot allows the user to save the current screen
capture as a .jpg.

e  Print Screenshot allows the user to save the current screen
capture as a .pdf.

e  Exit stops running the application software.

|: Sawe A3 @
Save jn: ADATEH Evaulaltion Software - @2 E

Mo iterns match your search,
b

Recent Places

Desktop

—
Libraries

LY

Camputer

“w

Metwaork
P e -

Save as lpe: |Enmma Separated Value [*.csv] - ‘ ‘ Cancel |

14981-050

Figure 19. Save As Dialog Box

The Edit menu (Label 1 in Figure 18) provides the option to
reset the software to its initial state (Reinitialize to Default
Values).

The Help menu (Label 1 in Figure 18) offers information about the

e  Analog Devices Website
e  User Guide

e  Context Help

e About

When hardware is connected to the USB port, the software
automatically detects which generic is connected and displays it
(Label 2 in Figure 18).

The Throughput box is Label 3 in Figure 18. The default value
is the maximum sample rate that the active device can support
without turbo mode enabled. The maximum supported
throughput of 2 MSPS (or 1.8 MSPS for the AD4020) can only
be achieved by enabling turbo mode (Label 11 in Figure 18).
If the user enters a value larger than the ability of the existing
device, the software reverts to the maximum throughput. The
user can adjust the throughput to a minimum of 10 kSPS.

The Voltage Reference dropdown menu is Label 4 in Figure 18. By
default, this reference is 5 V (ADR4550 on-board reference). The
minimum/maximum voltage calculations are based on this
reference voltage. If the user changes the reference voltage, this
input must be changed accordingly.

Click Single Capture to perform a single capture and click
Continuous Capture to perform a continuous stream capture
from the ADC. (Both are noted with Label 5 in Figure 18.)

Select Samples (Label 6 in Figure 18) to analyze data using the
particular number of samples. The maximum number of samples
the software can support is 524,288.

Four capture tabs (Label 7 in Figure 18) display the data in
different formats, as follows:

e  Waveform
e Histogram
e FFT

e  Summary

Click Enable Status Bits (Label 8 in Figure 18) to enable the
content of status header. Status bits can be clocked out at the end
of the conversion data using six extra clocks when it is enabled.

Click Span Compression (Label 9 in Figure 18) to enable the
ADC span compression feature. In single-supply applications,
the use of span compression increases the headroom and
footroom available to the ADC driver by reducing the input
range by 10% from the top and bottom of the range while still
accessing all available ADC codes.

Click High-Z Mode (Label 10 in Figure 18) to enable the internal
high-Z mode. Enabling this mode allows the low input current
for the ADC and improves THD performance using low power/
bandwidth precision ADC drivers for slow/dc type signals.

Click Turbo Mode (Label 11 in Figure 18) to enable turbo mode
and run the ADC at the full throughput of 2 MSPS.

Click Read Register (Label 12 in Figure 18) to check if any of the
ease of use features are enabled, including span compression,
high-Z mode, turbo mode, an overvoltage condition (which is a
sticky bit), and the status bits.

Clicking Enable Status Bits enables the six status bits, and the
content of the six bits is updated and displayed in the Status
Header section (Label 13 in Figure 18) after clicking single or
continuous capture. Note that the overvoltage clamp flag status
bit updates on a per conversion basis.

When the Busy indicator (Label 14 in Figure 18) is lit, the user
must wait until the software completes the data analysis.

This software allows the user to select the Oversampling Ratio
(Label 15 in Figure 18) up to 256 from the dropdown menu
located in the Configure tab. The oversampling capability is
implemented in the evaluation software by averaging the ADC
output samples, that is, by summing the number of ADC
samples and dividing it by the oversampling ratio to obtain the
increased dynamic range.
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To exit the software, click File > Exit. Copy Data

Within any of the chart panels, the tools shown in Table 4 allow | Description and Tip..

user control of the different chart displays. | wisible Items »
Clear Graph

Table 4. Graphical User Interface (GUI) Tools

Create Annotation

Symbol Description
= This tool controls the cursor, if present.

. . 1 o AutoScale X
| This tool zooms in and out.

| AutaScale Y

@T” This tool is used for panning.  Smooth Updates
The evaluation software allows the user to export the raw data | v Tgnore Time Stamp
or image. Right clicking any of the four capture tabs (Waveform, | o Ignore Attributes
Histogram, FFT, and Summary) open the menu as shown in Export Data To Cliphaard
Figure 20, and the user can either export the raw data in Excel «port Data To Exce
format or save an image in .bmp, .eps, or .emf format. Export Data To DlAdem

14981-051

Export Sirmplified Image..,
Figure 20. Export Raw Data or Image

Rev.D | Page 11 of 26




UG-1042

WAVEFORM CAPTURE

Figure 21 illustrates the waveform capture. The input signal is a
1 kHz sine wave. The waveform analysis reports the amplitudes
recorded from the captured signal in addition to the frequency of

the signal tone.

AD400X Evaluation Software

Configure | Waveform | Histogram | FFT | Summary

123763

ANALOG
DEVICES

Samples| 131072 ¥ |

Single Capture

| |Continuaus Capture]

@

imm
100000
50000

[=tujululu]

40000

20000 =

u] T

Code

-20000 ———

-40000

60000 |—F

50000

-100000 F—

I

¥

1
I
1

]
f
i
i

3

-123741
10998

16000 12000

Waveform Analysis

Pk-pk Amplitude | 9.4415283 |y | 247504 | gp
Max Amplitude | 4.7211838)y | 123763 || 5p

Min smplitude | -+ 720344y -123741)) g

Data analysis complete

20000 22000 24000
Time

26000

28000

Mean 00037658 + |98.718 | cp

Standard Deviation | 3.3389289 vV |87328 || gp

Frequency | 1.007

Figure 21. Waveform Tab
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ACTESTING—HISTOGRAM

DC TESTING—HISTOGRAM

The ac testing histogram tests the ADC for the code distribution More commonly, the histogram is used for dc testing where the
for the ac input, computes the mean and minimum/maximum user tests the ADC for the code distribution for dc input, computes
amplitude and LSB size of the converter. Raw data is captured the mean and standard deviation, or transition noise, of the
and passed to the PC for statistical computations. To perform a converter, and displays the results. Raw data is captured and
histogram test, click the Histogram tab and click Single Capture passed to the PC for statistical computations. To perform a

or Continuous Capture. Note that an ac histogram needs a histogram test, click the Histogram tab and click Continuous
quality signal source applied to the J6 and J10 input connectors. Capture. Note that a histogram test can be performed without an
Figure 22 shows the histogram for a 1 kHz sine wave applied to external source using a Vrer/2 (590 Q resistor divider) at the

the ADC input and illustrates the different measured values for ADC input. To test other dc values, apply a source to the J6 and

the data captured.

J10 input connectors. It may be required to filter the signal to
make the dc source noise compatible with that of the ADC.

AD400X Evaluation Software 3%'&%%

Configure | Waveform | Histogram | FFT | Summary

Samples 131072 z‘ | Single Capture ||C0ntinuuus Capture] e

i

28000+

26000

24000

22000

20000

18000

Qccurance

16000

14000

12000 o]

10000

8000~

é-...,....m

-120000 -100000 -20000 -60000 -40000

Histogram Analysis

Max Amplitude | 47211838 v | 123763

Min amplitude | -4,7203445 | v | -123741
DC Offset/Mean | 00037658 v | 99
Transition Moise | 33389289« | 87528

Data analysis complete

LsB
LsB
LsB
LsB

pEmam nEnsn]

{ |

1
-20000 a 20000 40000 60000 20000 100000 120000
Bins

Pk-pk Amplitude | 9.44153 | | 247504 | 5p
RMS | B.6752 W

LSE | 38.147 U
Histogram Width | 247504 LSB

14981-019

Wersion 1.1.0.0 Busy @

Figure 22. Histogram Tab, Histogram Captured for Sine Wave
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ACTESTING—FFT CAPTURE

The traditional ac characteristics of the converter can be
displayed on the FFT tab. As in the histogram test, raw data is
captured and passed to the PC where the FFT is performed,
displaying signal-to-noise ratio (SNR), signal-to-noise-and-
distortion ratio (SINAD), total harmonic distortion (THD),
and spurious-free dynamic range (SFDR). The data can also

be displayed in the time domain. To perform an ac test, apply

a sinusoidal signal to the evaluation board at the SMA inputs, J6
and J10. A low distortion, better than 100 dB signal is required
to allow true evaluation of the device. One possibility is to filter
the input signal from the ac source. A band-pass filter can be
used, and its center frequency must match the test frequency of

interest. Furthermore, if using a low frequency band-pass filter
when the full-scale input range is more than a few volts peak-to-
peak, use the on-board amplifiers to amplify the signal, thus
preventing the filter from distorting the input signal.

Figure 23 displays the histogram of the captured data that includes
the following:

e The spectrum information.

e  The fundamental frequency and amplitude in addition to
the second to fifth harmonics.

e  The performance data (SNR, dynamic range, THD,
SINAD, and noise performance).

| Configure | Waveform I Histograrm | FFT | Surnmary | Samples| 131072 Z‘ [ Single Capture ] [Cuntinuuus Capture] o
1]
-20
-40
-60
@
T -80
i
= 100
B
2 .1z0 [
I
-140
-160
-180 m i
200 I
u] 200000 400000 Go00000 g00000 090984, 7412
Frequency (Hz)
FFT Analysis
Max amplitude | 4.721184)y [ 123763 | 158 Fund. Frequency | 1.00708 | kHz SNR|9B.42  |gg  Binwidth[1526 |Hz
Min Amplitude | -4,72034! v —123?41- L5SB Fund. Amplitude | -0.5007 | dgFs THD | -111.45 |dB SFOR 11253 dB
Pk-pk Amplitude | 9,441528 v | 247504 . LSB Dynamic Range | 99,1951 | dpFs SINAD | 98.2 de
DC 0.003766 0y |99 | LSE RMS | B.675161 v Moise Floor| -143.97 | g4p
Show Harmonic Content]

Data analysis complete

14981-020

Wersion 1.1.0.0 Busy .

Figure 23. FFT Tab (AD4003 Running in Turbo Mode)
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SUMMARY TAB

The Summary tab captures all the display information and
provides them in one panel with a synopsis of the information,
including key performance parameters, such as SNR and THD.

i ANALOG
AD400X Evaluation Software PEARS
‘. T 5 — E"Histogram E FFr"i Summary | Samples| 131072 z‘ [ Single Capture | IContinuous Capture] o
Waveform 18 FFT
123763 0
100000 'ﬂ' ’nl IﬂlI ﬂ | -ln‘. o0
o 114 RN AR A
l T o 40
<sooo PRI TR TR g
i o
25000 ||\ I \’ || il \ I l f & 60
B I | E}
T 0 (LT il ll 1 1l 2 8
© _zs000 {1 ]I N T = .
o000 LT TR T T TR
5000 IR TR AT
| |
-100000I TR R ARV
WA VTN
R 0 500000 009984 74
13934 17500 EDDTD_D 22500 25000 27326 Frequency (Hz)
Ime
Histogram ]
28000 - SN Analysis Summary
26000 HHHH _
24000 -+ — Pk-pk Amp | 0.44153 |y | 247504 | LSB Dynamic Range | 99,195  |gp
3 22000-—++ aasaamas HHEE — DC Offset/Mean 0003785y [08718 | LB SNR 98418 |gp
Eigggg L A B A & e amas Aaal I Anat Transition Moise| 3,33893 |+ (87528 LSB THD -111.454 gp
glﬁDDD Hif T :. F i :. :.: : :. F : i Fund Freq. | 1,00708 | kbz S/M+D 98,204 B
14000 -F S Fund Amplitude | 0501 |gars 158 38147y
12000 -+ :
10000-HE e —— RMS | 6.67516 |, SFOR (112,529 |gp
2000, I_Ir—'lr——i—ll_I AR
-150000 -50000 u] 50000 100000 150000
Bins
g

Data analysis complete Version 1.1.0.0 Busy .

Figure 24. Summary Tab, Shows All Captured Windows
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TROUBLESHOOTING

SOFTWARE HARDWARE
To troubleshoot the software, take the following steps: To troubleshoot the hardware, take the following steps:
1. Always install the software before connecting the hardware to 1. If the software does not read back any data, do the following:

the PC.

2. Always allow the install to fully complete (the software is a
two-part installation, the ADC evaluation software and the
SDP-H1 drivers). A restart is recommended after
installation is finished.

3. When the user first plugs in the SDP-H1 board via the USB
cable provided, allow the Found New Hardware Wizard to
run, which may take a little time. However, allow this to
happen before starting the software.

4. Ifthe board does not appear to be functioning, ensure that
the ADC evaluation board is connected to the SDP-H1 board
and that the board is being recognized in the Device Manager,
as shown in Figure 14.

5. If connected to a slower USB port where the SDP-H1 cannot
read as quickly as it needs to, a timeout error may result. In 2.
this case, it is advised not to read continuously, or
alternatively, to lower the number of samples taken.

Rev. D | Page 16 of 26

a.  Check that the power is applied within the power
ranges described in the Power Supplies section.

b.  Using a voltmeter, measure the voltage present at each
of the test points: +Vs, —Vs, IPSV_VDD, VDD_1P8YV,
+3P3V, +5V, and REF1 and common-mode voltages
(REF/2) at IN+ and IN- to ensure that they are
correct. The SDP-H1 board LED1 must be lit.

c.  Launch the software and read the data. If nothing
happens, exit the software.

d.  Power down the board and relaunch the software.

e. Ifno data is read back, confirm that the ADC evaluation
board is connected to the SDP-H1 board and that the
board is being recognized in the Device Manager, as
shown in Figure 14.

When the user is working with the software in standalone/

offline mode (no hardware connected) and later chooses to

connect hardware, close and relaunch the software.
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EVALUATION BOARD SCHEMATICS AND ARTWORK
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Figure 25. ADC Evaluation Board, Power Supplies
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Figure 28. ADC Evaluation Board, SDP-H1 Connector and Glue Logic
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Figure 29. ADC Evaluation Board Silkscreen, Top Layer
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Figure 30. ADC Evaluation Board, Layer 1

Rev.D | Page 21 of 26




D
=
=]
S
S
D
(72
=
(224
X
=
=
==
<T
»
=
=
.
(2]
@
S
o
=
[
1
S
&o™N
5
o
—
¥
©
—
(704
=]
=
D
»
S
(—4
S
<
=)
<z
D
(72
=
o
==
==
(7¢]
(3]
L
o~
<
=
i
(1]
=

620-T86VT

O O O o
Q0O C0O
0
00

O 0

O

Figure 31. ADC Evaluation Board, Layer 2
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PRODUCTS ON THIS EVALUATION BOARD

AD4000/AD4001/AD4003/AD4020 BILL OF MATERIALS

Table 5. Bill of Materials

Name Part Description Manufacturer Part Number Stock Code

U1 16-/18-bit, 2 MSPS or 20-bit, 1.8 MSPS | Analog Devices See Table 3 SeeTable 3
precision SAR ADC in 10-lead MSOP

U2 Ultralow power, low distortion ADC | Analog Devices ADA4940-1 Do not place
driver, 4 nV/VHz

U3 High voltage, 1.2 MHz/600 kHz, Analog Devices ADP2370 ADP2370ACPZ-5.0-R7
800 mA, low quiescent current
buck regulator

U4 Linear regulator, 3.3V, ultralow Analog Devices ADP7118 ADP7118AUJZ-3.3-R7
noise, CMOS

ué Ultralow noise, high accuracy Analog Devices ADR4550 ADR4550BRZ
voltage reference

u7 CMOS, switched capacitor voltage Analog Devices ADM660 ADM660ARZ
converter

us IC EEPROM, 2 kb, 400 kHz, 8-lead ST M24C02-WMN6TP Digikey 497-8552-1-ND
SOIC

U12, U14 (only for Low noise, high speed amplifiers Analog Devices ADA4807-1 ADA4807-1ARJZ

AD4001/AD4003/

AD4020)

U12, U14 (only for Low noise, high speed amplifiers Analog Devices ADA4805-1 ADA4805-1ARJZ

AD4000)

u16,U18 Low noise, high speed amplifiers Analog Devices ADA4807-1 ADA4807-1ARJZ

u1iz Linear regulator, 3.3V, ultralow Analog Devices ADP7118 ADP7118AUJZ-3.3-R7
noise, CMOS

u19 Linear regulator, 1.8V, ultralow Analog Devices ADP7118 ADP7118AUJZ-1.8-R7
noise, CMOS

u20 Ultralow power step-down regulator | Analog Devices ADP5300 ADP5300ACPZ-1-R7

u21 -28V, =200 mA, low noise, linear Analog Devices ADP7182 ADP7182AUJ-2.5-R7
regulator

u22 Micropower, high accuracy, 5V Analog Devices ADR3450 ADR3450ARJZ-R2
voltage reference

C1,C2,C5, 09, C61 10 pF, 20V tantalum capacitors AVX TAJB106K020RNJ FEC 197427

C3,C4,C16,C17,C21, 2.2 yF, X7R, 16V, 0805 capacitors, Murata GRM21BR71C225KA12L | FEC 1828829

C26 MLCC

cé 4.7 yF, 16V, X7R, 0805 ceramic Taiyo Yuden EMK212B7475KG-T FEC 1853520
capacitor

C7,C10,C12,C18, C40, 10 pF, 16V, 0805 capacitors Murata GRM219R61C106KA73D | FEC 1845747

C68, C73,C74,C75,

C76,C77

C8,C57,C64,C69,C71 | 1 pF, X7R, 50V, 0805 capacitors Murata GRM21BR71H105KA12L | FEC 1735541

C14,C15 100 nF, X7R, 25V, 0805 capacitors Murata LLL216R71E104MAO1L FEC 1294646

C24, C30,C37,C41, 0.1 uF, X7R, 50 V ceramic capacitors | Murata GRM188R71H104KA93D | FEC 8820023

C42, C44, C45, C48,

C54, C60, C66, C67, C70

C35,C52 180 pF, 50V, 0603, COG/NPO YAGEO CCO0603JRNPO9BN181 FEC 3019494
capacitors (Phycomp)

C11,C13,C19, C20, SMD capacitors Not applicable Not applicable Do Not Place

C25, C29, C32C36, C38,

(€39, C43, C46, C47,

C49, C50, C51, C55,

C63,C72

C56 10 uF, X5R, 25V, 0805, MLCC Murata GRM219R61E106KA12D | FEC 2426961
capacitor

€58, C65 2.2 uF, 50V, 0805, X7R capacitors TDK C2012X7R1H225K125AC | FEC 2346945
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Name Part Description Manufacturer Part Number Stock Code

C186 SMD capacitor EPCOS B37921C9104K60 Digikey 495-3265-1-ND

L1 1000 Q at 100 MHz, 1206, WE-CBF Wurth 742792141 WURTH 742792141
SMD, EMI suppression ferrite

L3 10 pH, inductor, shielded power, Coilcraft XAL4040-103ME XAL4040-103ME
XAL40 series

L4 2.2 pH, inductor, shielded power, Coilcraft XAL4020-222MEB COILCRAFT XAL4020-222MEB
XAL40 series

LED1 LED, SMD green OSRAM LGQ971 Digikey 475-1409-1-ND

R1 2.4kQ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W060312K4 FEC 9330879

R2 100 kQ, 0.1 W, 1%, 0805 resistor Multicomp MCO01W08051100K FEC 9332405

R3,R11,R12,R13,R14, 0 Q, SMD resistors Multicomp MC 0.063W 0603 OR FEC 9331662

R20, R21, R23, R25, R36,

R38, R40, R42, R44, R46,

R48, R50, R51, R52, R53,

R59, R66, R68, R69, R73,

R74,R75,R77,R78,R79,

R85, R86, R90, R91, R95,

R96, R99, R100

R4, R5, R8, R9 1 kQ, 0.063 W, 1%, 0603 resistors Multicomp MC0063W060311K FEC 9330380

R7 88.7 kQ, 1%, 0805 resistor Vishay Draloric CRCWO080588K7FKEA FEC 2139026

R10 1%, 0805 resistor Multicomp MCO1WO08050R FEC 9333681

R17,R22,R32, R37 49.9 (), 0.1 W, 0.1%, 0805 resistors Panasonic RN73C2A49R9BTG FEC 1140694

R24, R41 200 Q, 0.1 W, 1%, 0805 resistors Multicomp MCO0T1WO08051200R FEC 9332758

R27, R28, R34, R35 Thick film chip resistors Vishay Draloric CRCWO0805590RFKEA FEC 1653021

R45, R65, R67 10 kQ, 0.1 W, 1%, 0805 resistors Multicomp MCO0T1W0805110K FEC 9332391

R93 20 kQ, 0.063 W, 1%, 0603 resistor Multicomp MC0063W0603120K FEC 9330771

R6, R15, R16, R18, R19, SMD resistors, 0603 Not applicable Not applicable Do not place

R26, R29, R30, R31, R33,
R39, R43, R49, R54, R55,
R56, R57, R58, R60, R70,
R71,R72, R76, R80, R84,
R87, R88, R89, R92, R94,
R97, R98, R101

Table 6. Evaluation Board Models

Product Ordering Model Sample Rate (MSPS) Resolution (Bits) Package Used on Evaluation Board
AD4000BRMZ EVAL-AD4000FMCZ 2 16 10-lead MSOP
AD4001BRMZ EVAL-AD4001FMCZ 2 16 10-lead MSOP
AD4003BRMZ EVAL-AD4003FMCZ 2 18 10-lead MSOP
AD4020BRMZ EVAL-AD4020FMCZ 1.8 20 10-lead MSOP

RELATED LINKS

Resource Description

ADA4805-1 Product Page, ADA4805-1, 0.2 uV/°C Offset Drift, 105 MHz Low Power, Low Noise, Rail-to-Rail Amplifier
ADA4807-1 Product Page, ADA4807-1, Low Power, Low Noise and Distortion, Rail-to-Rail Output Amplifier
ADA4940-1 Product Page, ADA4940-1, Ultralow Power, Low Distortion, Fully Differential ADC Driver

ADR3450 Product Page, ADR3450, Micropower, High Accuracy 5.0 V Voltage Reference

ADR4550 Product Page, ADR4550, Ultralow Noise, High Accuracy 5.0 V Voltage Reference

ADP7118 Product Page, ADP7118, 20V, 200 mA, Low Noise, CMOS LDO

ADP7182 Product Page, ADP7182, —28 V, 200 mA, Low Noise, Linear Regulator

ADM660 Product Page, ADM660, CMOS Switched Capacitor Voltage Converter

ADP2370 Product Page, ADP2370, High Voltage, 1.2 MHz/600 kHz, 800 mA, Low Quiescent Current Buck Regulator
ADP5300 Product Page, ADP5300, 50 mA/500 mA, High Efficiency, Ultralow Power Step-Down Regulator
EVAL-SDP-CH1Z Product Page, High-Speed Controller Board for System Demonstration Platform (SDP-H1)

AN-931 AN-931 Application Note, Understanding PulSAR® ADC Support Circuitry
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NOTES

ESD Caution
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
‘m circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc.
("ADI"), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal,
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (i) permit any Third Party to access the Evaluation Board. As used herein, the term
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board.
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER'S POSSESSION OR USE OF
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable
United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

©2016-2017 Analog Devices, Inc. All rights reserved. Trademarks and AN ALOG
registered trademarks are the property of their respective owners.
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